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1. Introduction to 3CX Phone System for Windows 

What is 3CX Phone System for Windows? 

3CX Phone System is a software-based IP PBX that replaces a traditional PBX and 

delivers employees the ability to make, receive and transfer calls. The IP PBX supports 

all traditional PBX features. An IP PBX is also referred to as a VOIP Phone System, IP 

PABX or SIP server. 

Calls are sent as data packets over the computer data network instead of via the 

traditional phone network. Phones share the network with computers and separate phone 

wiring can therefore be eliminated.  

With the use of a VOIP gateway, you can connect existing phone lines to the IP PBX and 

make and receive phone calls via a regular PSTN line. The 3CX phone system uses 

standard SIP software or hardware phones, and provides internal call switching, as well 

as outbound or inbound calling via the standard phone network or via a VOIP service.  

Benefits of an IP Phone System / IP PBX 

Much easier to install & configure then a proprietary phone system: 

A software program running on a computer can take advantage of the advanced 

processing power of the computer and user interface of Windows. Anyone with an 

understanding of computers and windows can install and configure the PBX. A 

proprietary phone system often requires an installer trained on that particular proprietary 

phone system. 

Easier to manage because of web based configuration interface: 

A VOIP phone system has a web based configuration interface, allowing you to easily 

maintain and fine tune your phone system. Proprietary phone systems often have difficult 

to use interfaces which are designed so that only the phone system installers can use it 

effectively.  

Call cost reduction: 

You can save substantially by using a VOIP service provider for long distance or 

international calls. Easily connect phone systems between offices/branches via the 

Internet or WAN and make free phone calls.  

No need for separate phone wiring – use computer network: 

A VOIP phone system allows you to connect hardware phones directly to a standard 

computer network port (which it can share with the adjacent computer). Software phones 

can be installed directly onto the PC. This means that you do not need to install & 

maintain a separate wiring network for the phone system, giving you much greater 

flexibility to add users/extensions. If you are moving into an office and have not yet 

installed phone wiring, you can save significantly by just installing a computer network.  

No vendor lock-in: 
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VOIP phone systems are open standard – all modern IP PBX systems use SIP as a 

protocol. This means that you can use almost any SIP VOIP phone or VOIP gateway 

hardware. In contrast, a proprietary phone system often requires proprietary phones, 

designed specifically for that phone system and proprietary expansion modules to add 

features and lines.  

Scalable: 

Proprietary systems are easy to outgrow: Adding more phone lines or extensions often 

requires expensive hardware upgrades. In some cases you need an entirely new phone 

system. Not so with a VOIP phone system: a standard computer can easily handle a 

large number of phone lines and extensions – just add more phones to your network to 

expand!  

Better customer service & productivity: 

Because calls are computer based, it i s much easier for developers to integrate with 

business applications. For example: an incoming call can automatically bring up the 

customer record of the caller, dramatically improving customer service and cutting cost. 

Outbound calls can be placed directly from Outlook, removing the need for the user to 

type in the phone number.  

Software based Phones are easier to use: 

It i s often difficult to use advanced phone system features such as conferencing on 

proprietary phones. Not so with software based SIP phones – all features are easily 

performed from a user friendly windows GUI.  

More features included as standard: 

Because a VOIP phone system is software based, it is easier for developers to improve 

feature sets and performance. Therefore most VOIP phone systems come with a rich 

feature set, including auto attendant, voice mail, call queuing and more. These options 

are often very expensive in proprietary systems.  

Better control via better reporting: 

VOIP settings store inbound and outbound call information in a database on your server, 

allowing for much more powerful reporting of call costs and call traffic.  

Better overview of current system status and calls: 

Proprietary systems often require expensive ‘system’ phones to get an idea what is going 

on in your phone system. Even then, status information is cryptic at best. With VOIP 

systems you can define which users can see phone system status graphically via a web 

browser.  

Allow users to hot plug their phone anywhere in the office: 

Users simply take their phone, plug it into the nearest Ethernet port and they keep their 

existing number!  

Allows easy roaming of users: 

Calls can be diverted anywhere in the world because of the SIP protocol characteristics  

For more information about the benefits of an IP PBX, visit the IP PBX FAQ at 

http://www.3cx.com/PBX/IP-PBX-faq.html 

http://www.3cx.com/PBX/IP-PBX-faq.html
http://www.3cx.com/PBX/IP-PBX-faq.html
http://www.3cx.com/PBX/IP-PBX-faq.html
http://www.3cx.com/PBX/IP-PBX-faq.html
http://www.3cx.com/PBX/IP-PBX-faq.html
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How an IP Phone system works 

A VOIP Phone System, also referred to as an IP PBX, consists of one or more SIP 

standard based phones, an IP PBX server and optionally a VOIP Gateway. The IP PBX 

server is similar to a proxy server: SIP clients, being either soft phones or hardware 

based phones, register with the IP PBX server, and when they wish to make a call they 

ask the IP PBX to establish the connection. The IP PBX has a directory of all 

phones/users and their corresponding sip address and thus is able to connect an internal 

call or route an external call via either a VOIP gateway or a VOIP service provider. 

 

Figure 1 - VOIP Phone System Overview 

The image illustrates how an IP PBX integrates on the network and how it uses the PSTN 

or Internet to connect calls. 

For more information about how an IP PBX works, visit the IP PBX FAQ at 

http://www.3cx.com/PBX/IP-PBX-faq.html 

SIP phones 

A VOIP phone system requires the use of SIP phones. These phones are based on the 

Session Initiation Protocol (SIP), an industry standard to which all modern IP PBXs 

adhere. The SIP protocol defines how calls should be established and is specified in RFC 

3261. Because of SIP, it is possible to mix and match IP PBX software, phones and 

gateways. This protects your investment in the phone hardware. SIP phones are 

available in several versions/types: 

http://www.3cx.com/PBX/IP-PBX-faq.html
http://www.3cx.com/PBX/IP-PBX-faq.html
http://www.3cx.com/PBX/IP-PBX-faq.html
http://www.3cx.com/PBX/IP-PBX-faq.html
http://www.3cx.com/PBX/IP-PBX-faq.html
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Software based SIP phones 

A software based SIP phone is a program which makes use of your computers 

microphone and speakers, or an attached headset to allow you to make or receive calls. 

Examples of SIP phones are the included 3CX VOIP Client, SJPhone from SJlabs or X-

Lite from Counterpath.  

Hardware based SIP Phones 

 

Figure 2 - A hardware sip phone 

A hardware based SIP phone looks like and behaves like a normal phone. It’s actually a 

mini computer that connects directly to the computer network. Because they have an 

integrated mini hub, they can share a network connection point with a computer, 

eliminating the need for an additional network point for the phone. Examples of hardware 

SIP phones are GrandStream GXP-2000 or SNOM 320. 

Analogue phones / Fax machines using an ATA adapter 

 

Figure 3 - An ATA adapter 

If you want to use your current phone or analog fax machine with the VOIP phone 

system, you can use an ATA adapter. An ATA adapter allows you to plug in the Ethernet 

network jack into the adapter and then plug the phone into the adapter. This way your old 

‘regular’ phone will appear to the VOIP phone system software as a SIP phone. 

3CX Phone System editions 

3CX Phone System is available in 4 different versions – a Free Edition, a MINI edition, a 

Small Business Edition, a Pro Edition and an Enterprise edition. A detailed feature 
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comparison between versions is available a t this location: http://www.3cx.com/phone-

system/enterprise-features.html 

Pricing information and ordering information can be found here: 

http://www.3cx.com/ordering/index.php 

What’s new in 3CX Phone System V7? 

All versions 

· Completely revamped interface, with many usability improvements 

· Ability to set advanced forwarding rules per extension based on caller ID and time 

· Apache was replaced by a Microsoft Web Server, Cassini, which is more windows 

friendly 

· Added support for running as a virtual instance in Hyper V 

· New configuration wizard which makes first setup easier 

· Improved performance of system. 

Small Business, Pro and Enterprise editions 

· New, easier to navigate MyPhone interface 

· Ability to offer callers a way to exit out of the queue and leave a message instead of 

waiting 

· Ability to have callers go straight to voice mail if no one is manning the queue. 

· Support for using Sangoma cards as VoIP Gateways, either installed on the same 

machine or on a remote machine 

· Resolve inbound calls to an outlook contact – incoming calls can automatically bring 

up the appropriate contact record based on the caller ID  

 

http://www.3cx.com/phone-system/enterprise-features.html
http://www.3cx.com/phone-system/enterprise-features.html
http://www.3cx.com/phone-system/enterprise-features.html
http://www.3cx.com/phone-system/enterprise-features.html
http://www.3cx.com/phone-system/enterprise-features.html
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2. Installing 3CX Phone System for Windows 

System requirements 

3CX Phone System for Windows requires the following: 

· Windows XP Pro, Vista, 2003 server or 2008 

· Port 5060 (SIP), 5090 (Tunnel - Optional) to be opened 

· Port 5480, 5482, 5483, 5485, 5486, 5487 to be free 

· One port for IIS, 3 if using Cassini (5000, 5481, 5484) 

· .NET Framework version 2.0 or higher 

· 1 Gigabyte Memory or higher, Pentium 4 processor or up 

Recommended 

· 3CX Supported SIP Phones ( http://www.3cx.com/sip-phones/index.html) & VOIP 

Gateways (http://www.3cx.com/voip-gateways/) 

· 3CX supported VoIP Providers 

· If you are using a VOIP provider, you must have a firewall that is configured to do 

static port mapping. A static IP is highly recommended also! For more information see: 

http://www.3cx.com/support/nat-firewalls.html 

· The web based management console is optimized for Internet Explorer v7. It also 

works with Firefox 2 & 3, however there are some minor display issues. 

· You will need to have a good basic understanding of Windows Networking. 

Windows 2008 users: 

You will need to install additional components. Go to 

1. Control Panel > Programs and Features 

2. Turn Windows Features on or off > Features 

3. Now Add features: Desktop Experience, Quality Windows Audio Video Experience 

(Optional). This will install all the codecs required by 3CX for audio in Windows.  

4. For the IE browser to work on the server, you must disable Internet Explorer 

Security Enhancement. To do this: 

a. Go to Start -> Programs -> Administrative Tools -> Server Manager 

b. Ensure that the root node is selected 

c. In the "Server Summary" section, in the "Security Information" sub-section, Click 

on the "Configure IE ESC" link. 

d. Set to "Off" for those types of users that will be administering the PBX. 

http://www.3cx.com/sip-phones/index.html
http://www.3cx.com/sip-phones/index.html
http://www.3cx.com/sip-phones/index.html
http://www.3cx.com/support/nat-firewalls.html
http://www.3cx.com/support/nat-firewalls.html
http://www.3cx.com/support/nat-firewalls.html
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Run set-up 

1. Download the latest version of 3CX Phone System from http://www.3cx.com/ip-

pbx/downloadlinks.html. Run set-up by double-clicking on the set-up file. Click ‘Next’ 

to start installation. 

2. You will be asked to review and approve the license agreement, as well as to choose 

an installation location. 3CX Phone System will need a minimum of approximately 50 

MB of free hard disk space. You will need to reserve additional space to store voice 

mail files & prompts. 

3. Select the installation location and click Next 

4. You will be asked whether you wish to use IIS or the in-built web server, Cassini. 

Cassini is more light weight, and independent of Windows updates or other IIS 

applications. Its only draw back is that when using the management console display is 

a bit slower, although overall phone system performance is NOT affected. Note that 

on Windows XP, IIS has a default 10 connection limit, although this can be increased 

to 40 using a script ( http://www.codinghorror.com/blog/archives/000329.html) 

5. Click ‘Install” to start the installation of 3CX Phone System. Setup will now copy all 

files and install the necessary Windows services. After set-up has completed copying 

files and installing the services, set-up will run the 3CX Phone System Configuration 

Wizard to complete the install. Click ‘Finish’.  

Run the 3CX Phone System configuration wizard 

1. The 3CX Phone System configuration wizard walks you through a number of essential 

tasks that you need to do in order to get your system up and running. After it starts up, 

it will ask in which language you want the wizard to run. 

2. The wizard will ask you how many digits you wish your extension numbers to be.  

3. Set-up will prompt you for the FQDN of 3CX Phone System. IP phones contact the 

phone system server using an IP OR an FQDN. If using an FQDN, then you must 

specify the FQDN of the server. This value is not relevant if you specify the IP of the 

s e r v e r  i n  the phone configuration. For more information, see 

http://www.3cx.com/support/sip-domain.html 

4. It will ask you for your mail server name and reply to address. These settings are 

used to send email notifications, voice mail and faxes.  

5. It will ask you for a preferred username and password to be used to logon to the 3CX 

Phone System management console and manage the phone system.  

http://www.3cx.com/ip-pbx/downloadlinks.html
http://www.3cx.com/ip-pbx/downloadlinks.html
http://www.3cx.com/ip-pbx/downloadlinks.html
http://www.codinghorror.com/blog/archives/000329.html
http://www.3cx.com/support/sip-domain.html
http://www.3cx.com/support/sip-domain.html
http://www.3cx.com/support/sip-domain.html
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Screenshot 1 - The 3CX Configuration Wizard 

6. Set-up will allow you to create a number of extensions. You can create more later, 

however you need to create at least one extension. After you have created the 

extensions, you need to configure your phone sets. 3CX has configuration guides for 

many popular phones at http://www.3cx.com/sip-phones/index.html  

7. In the next step it will ask you to specify the operator extension. The operator 

extension is the default extension used to route inbound calls to. Specify which 

extension will act as the operator extension. The operator extension will be the default 

destination for all inbound lines and DID’s 

8. To add VOIP Gateways or VOIP providers follow the instructions provided in the 

screen. 

9. 3CX Phone System Wizard will prompt you whether you would like to receive a quote 

for a complete phone system. If yes, fill in your details and 3CX or a 3CX partner will 

send you a detailed quote. You can skip this step if you wish. 

After the Wizard has completed, you can connect to the 3CX Phone System Management 

Console by clicking on the management console short cut in the 3CX Phone System 

program group. 

To connect to the management console from a remote machine, start a web browser and 

enter the name of the machine on which 3CX Phone System is installed, followed by 

‘Management’. (For example: http://phone-system/Management) If you are using Cassini, 

you have to append the port number, 5481. For example http://phone-system:5481 

http://phone-system/Management
http://phone-system/Management
http://phone-system/Management
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Upgrading from a previous version of 3CX Phone System 

It is possible to upgrade a 3CX Phone System 6.1 or 7.0 installation to version 7.1 as 

follows: 

1. Before uninstalling, backup your current configuration using the backup and restore 

tool located in the 3CX program group.  

2. Now uninstall using Add/Remove programs. 

3. Install 3CX Phone System v7.1 – You will be prompted for the backup file by the 

configuration wizard. This will restore your configuration. 

Notes in regards to upgrades from v6.1 & 7.0 

· Call logs will not be automatically backed up and restored. This is because 

numerous improvements to call reporting have been made that require a change 

of format. From 7.1 onwards call logs will be backed up and restored. 

Notes in regards to upgrades from v6.1:  

· DIDs & bridges created in version v6 are not restored in v7. These need to be re-

created. 

· Upgrades of version 3.1, 5, 6.0 configurations are not supported. In these cases, 

make a backup of your old configuration. Install v6.1 on to a separate machine, do 

a restore it and then a backup. Then restore that 6.1 backup to v7. 

· If you upgraded from v6 or v7 (Cassini) and switched to IIS, you must go into each 

extension and click ‘save’ so as to recreate the provisioning file for the extension 

(since the URL changed). Also you will need to change the URL to the 

provisioning server in each phone. You can either do this manually for each phone 

according to the configuration guide, or automatically using ‘option 66’ in your 

DHCP server. See this URL for a configuration guide http://www.3cx.com/sip-

phones/DHCP-option-66.html 

· Tunnel Configurations will not be restored when restore from 6.1.   

· Certain forwarding rule combinations will not be restored either when upgrading 

from 6.1.  Therefore these will need to be double checked after a restore.   

· After a migration from 6 to 7, it is best to reboot all the phones in your network to 

rebuild the registration cache. Otherwise some phones will take up to 1 Hour to re-

register, depending on the default registration time.  

Activating 3CX Phone System 

If you have purchased a MINI, Small Business, Pro or Enterprise version then you can 

activate your license by going to the General > Activate License page in the 3CX 

Management Console. 

http://www.3cx.com/sip-phones/DHCP-option-66.html
http://www.3cx.com/sip-phones/DHCP-option-66.html
http://www.3cx.com/sip-phones/DHCP-option-66.html
http://www.3cx.com/sip-phones/DHCP-option-66.html
http://www.3cx.com/sip-phones/DHCP-option-66.html
http://www.3cx.com/sip-phones/DHCP-option-66.html
http://www.3cx.com/sip-phones/DHCP-option-66.html
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Screenshot 2 - Activating your license 

Enter your license key, Company, Contact Name, E-mail, Telephone and Country and 

click on “Activate” to activate your license. This information will be sent to our license key 

server and your license key and installation will be activated. You will need to do this 

each time you re-install 3CX Phone System or install an upgrade. 

Firewall configuration 

There are 2 scenarios in which you will need to update your firewall configuration: 

1. If your PBX server is behind a NAT / firewall and you intend to use a VOIP provider 

2. If you are using a firewall on the PBX server itself, for example Windows Firewall 

3CX Phone System behind a NAT / firewall 

The best place for 3CX Phone System i s  on a machine behind the firewall. This 

configuration is easier and more secure. If you will just use PSTN lines, you don’t even 

need to make any changes to your firewall configuration.  

If you intend to use a VOIP Provider, then you will need to open the following ports to 

allow 3CX Phone System to communicate with the VOIP Provider: 

· Port 5060 (UDP) for SIP communications (send & receive) MUST BE STATICALLY 

MAPPED. See sample firewall configuration at http://www.3cx.com/support/linksys-

configuration.html 

http://www.3cx.com/support/linksys-configuration.html
http://www.3cx.com/support/linksys-configuration.html
http://www.3cx.com/support/linksys-configuration.html
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· Port 5090 (TCP) for the 3CX Tunnel (if you plan to use the tunnel for remote 

extensions) 

· Port 9000-9003 (or higher) (UDP) (send & receive) for RTP communications, which 

contain the actual call. Each call requires 2 RTP ports, one to control to call and one 

for the call data. Therefore, you must open twice as many ports as you wish to 

support simultaneous calls via the VOIP provider. For example, if you want to allow 

4 people to make calls via the VOIP provider simultaneously, you must open port 

9000 to 9007. 

Note that the above port ranges are the default ports in 3CX Phone System. You can 

adjust these ports from the Management Console, in the General > General Settings 

page. In this page, you can configure the ports to be used for internal calls, and the ports 

to be used for external calls being made via a VoIP provider. 

Firewall installed on the 3CX Phone System machine 

If your phone system is running on the internal network behind a firewall, it is not 

necessary to enable the firewall on the machine running 3CX Phone System. However if 

you wish to do this, then you will have to open the following ports:  

· Port 5060, 5480, 5482, 5483, 5485, 5487 for 3CX Phone System 

· Port 5090 (TCP) for the 3CX Tunnel (if you plan to use the tunnel for remote 

extensions) 

· Port 7000 to 7500 (UDP) for internal leg of calls to VoIP providers or external 

extensions. 

· Port 9000-9003 (UDP) for the external leg of calls to VoIP providers or external 

extensions. Each call requires 2 RTP ports, one to control the call and one for the 

call data. Therefore, you must open twice as many ports as you wish to support 

simultaneous calls via the VOIP provider. For example, if you want to allow 4 people 

to make calls via the VOIP provider simultaneously, you must open port 9000 to 

9007. 

Note that the above port ranges are the default ports in 3CX Phone System. You can 

adjust these ports from the Management console. 

The 3CX Extension user manual 

The 3CX Extension manual explains users how they can use 3CX Phone System – it  

includes explanations of how to use 3CX Assistant, the voice mail system, call parking, 

the MyPhone user portal and so on. The latest manual can be downloaded from here: 

http://www.3cx.com/manual/3CXExtensionmanual71.pdf 

The 3CX Assistant 

The 3CX Assistant is a compact utility which allows you to easily manage your extension 

with a few mouse clicks – rather then via a cryptic and limited phone interface. 3CX 
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Assistant is not a phone – it works in tandem with an existing IP hardware phone, soft 

phone or even an analog phone. Calls are made and answered on your existing phone. 

3CX Assistant provides the following functions: Call Pop-up, Easy Call Transfer / Park, 

Presence, Click to Call and Queue monitoring. 

For more information about the 3CX assistant and how to install it, please refer to the 

Extension user manual. The 3CX assistant can be downloaded here: 

http://www.3cx.com/phone-system/downloadlinks.html 

3CX VoiP Phone 

The 3CX VoIP Phone is a small Windows application that allows you to make and receive 

calls via a headset connected directly to your computer. You can download the 3CX VoIP 

Phone and manual from here 

http://www.3cx.com/phone-system/downloadlinks.html 

http://www.3cx.com/phone-system/downloadlinks.html
http://www.3cx.com/phone-system/downloadlinks.html
http://www.3cx.com/phone-system/downloadlinks.html
http://www.3cx.com/phone-system/downloadlinks.html
http://www.3cx.com/phone-system/downloadlinks.html
http://www.3cx.com/phone-system/downloadlinks.html
http://www.3cx.com/phone-system/downloadlinks.html
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3. Creating Extensions 

Introduction 

After you have installed 3CX Phone System, you will need to follow a number of steps to 

complete the setup: 

1. Create 3CX Phone System extensions. 

2. Configure software and/or hardware SIP phones. 

3. Configure phone lines. 

Start-up the 3CX Management console from the 3CX program group, or point your web 

browser to the Management Console by entering the name of the machine, for example: 

http://phone-system/Management.  

A login page will appear. Enter the Username and Password that you provided during 

setup, select the language you would like to use and then click on the ‘Login’ button. 

Adding Extensions 

To add an extension, click on ‘Add Extension’ from the toolbar.  

 



 
 3CX Phone System for Windows System for Windows www.3cx.com 

 

Page 24 

Screenshot 3 - Adding an extension 

User and Authentication information 

1. Enter the extension number, first and last name and the Email address (Optional) of 

the user. The email address will be used for voice mail notifications and as the default 

SIP ID. You can leave the field empty if you wish. 

2. Now specify an authentication ID and password: 

· ID – The SIP ‘Username’. e.g. 200. 

· Password –The SIP Password (password can be hidden from the user). 

The Authentication ID and password fields set in the software or hardware phone 

must match the above fields! In addition the extension number must be entered in 

the phone as well in a field called Account, User ID or something similar to that. 

The exact field names differ per vendor. For detailed configuration guides for 

popular phones see http://www.3cx.com/sip-phones/index.html 

Voice mail options 

3. Now configure the Voice mail options.  

· Enable voice mail 

· Play Caller ID – the voicemail system will play the number of the caller who left the 

voice message 

· Read out date/time of message – the voicemail system will play back the time of the 

voice message to be played 

· PIN number – this pin number is used to protect the voice mailbox and is used by the 

user to access the mailbox. The PIN number is also used as a password to logon to 

3CX VOIP Client. 

· Email options – You can choose the following e-mail options when a voice mail 

arrives: 

o No email notification – The system will not send any emails 

o Send email notification only – This option will notify the user that there is a 

new voice mail. However the e-mail will not contain the voice mail, the voice 

mail will have to be retrieved via the phone. 

o Send vmail as attachment – This option will send an email and attach the 

voice mail as a WAV file to the e-mail. It will still leave the voice mail in the 

voice mail box just in case you wish to pick up the voice mail via the phone (by 

dialling 999). 

o Send as attachment and delete from mbox – will send an email with the voice 

mail attached AND delete the voice mail from the voice mailbox on the 3CX 

server. This avoids the user having to delete the voice mail from 2 locations, 

i.e. from the email inbox and from the 3CX voice mailbox. 

http://www.3cx.com/sip-phones/index.html
http://www.3cx.com/sip-phones/index.html
http://www.3cx.com/sip-phones/index.html
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4. Click OK to create the extension. 

Configuring the SIP phones 

After you have created the extension, a summary page will appear, which shows the 

information that the SIP phone will need:  

· Proxy server IP or FQDN: Host name of 3CX Phone System 

· User ID: Extension number created 

· Authentication ID: As specified in Authentication ID field 

· Password: As specified in Authentication password field 

This information can be entered into the phones manually, or can be provisioned to the 

phone. For the latest configuration guides how to manually configure your phone, go to: 

http://www.3cx.com/sip-phones/index.html 

Phone provisioning 

 

Screenshot 4 – provisioning a phone 

4. Phone provisioning – 3CX Phone System can automatically provision supported 

phones. Essentially, after you have configured an extension, 3CX will prepare a 

configuration file, and publish it via HTTP. The phone will be configured to retrieve its 

http://www.3cx.com/sip-phones/index.html
http://www.3cx.com/sip-phones/index.html
http://www.3cx.com/sip-phones/index.html
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configuration from the 3CX Phone system HTTP server and automatically configure 

itself. For more information how this works, see 

http://www.3cx.com/support/provisioning.html. You can find configuration guides for 

provisioning popular IP phones at  http://www.3cx.com/sip-phones/index.html. For 

larger networks it is recommended that you provision the provisioning URL to the 

phones via DHCP option 66. See this configuration guide for more information: 

http://www.3cx.com/sip-phones/DHCP-option-66.html  

To provision a phone, simply enter the MAC address of the phone (which can be found at 

the bottom of the phone), in the MAC address field. Then select the appropriate phone 

model and the Network interface (in case your phone system has multiple network 

interfaces) 

Optionally specify any BLF fields that must be automatically provisioned too. Match a BLF 

button with an extension, so that this button will show the status of that extension. The 

number of available BLF buttons varies per phone.  

Testing your setup 

As soon as you have created at least 2 extensions, and configured SIP software and/or 

hardware phones to work with those extensions, you can test whether your setup is 

working correctly. To do this: 

1. Check Phone System status with the status monitor 

 

Screenshot 5 - The Status monitor 

Load up the 3CX Phone System Management console, and click on the ‘Extension 

Status’ node. Check that all extensions are listed and are ‘Registered’. 

http://www.3cx.com/support/provisioning.html
http://www.3cx.com/sip-phones/index.html
http://www.3cx.com/sip-phones/index.html
http://www.3cx.com/sip-phones/index.html
http://www.3cx.com/sip-phones/DHCP-option-66.html
http://www.3cx.com/sip-phones/DHCP-option-66.html
http://www.3cx.com/sip-phones/DHCP-option-66.html
http://www.3cx.com/sip-phones/DHCP-option-66.html
http://www.3cx.com/sip-phones/DHCP-option-66.html
http://www.3cx.com/sip-phones/DHCP-option-66.html
http://www.3cx.com/sip-phones/DHCP-option-66.html
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If the phone is listed as ‘Not registered’ then the extension has been created, but the 

phone has not registered itself with the system. This could be because the device is off, 

or because the SIP credentials are incorrect. Check whether you have entered the 

Extension Number, Authentication ID and Authentication Password in the right fields 

Another cause could be that you have a firewall enabled on the machine running 3CX 

Phone System and that it is blocking communications between the server and the phone. 

2. Place a call to another extension 

If the status shows that the phones have registered correctly, you can make a call to 

another extension. The status monitor will show that you picked up one extension and are 

calling another.  

3. Troubleshooting tips 

If dialling another extension does not work, click on the Activity Log node. This screen 

shows the activity log of the server, and the log messages can indicate the reason of an 

error condition. For more information about the server status log, visit http://wiki.3cx.com. 

 

Screenshot 6 - 3CX Phone System Activity Log 

Forwarding rules - extension behaviour on busy, no answer etc. 

Using the forwarding rules feature, you can configure exactly what should happen to calls 

when an extension is busy, a call remains unanswered or when an extension is 

unregistered. You can also make forwarding rules based on the time that the call was 

received and the caller ID of the caller. 
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Screenshot 7 - Destination unreachable configuration 

To create a forwarding rule; 

1. Go to the Extensions node and double-click on the extension for which you want to 

create a forwarding rule. Click on the ‘Forwarding rules’ tab. Now specify the following 

rule options.: 

2. Rule type - Define to which calls this rule will apply: 

· No Answer – You will need to specify the time in seconds that you want the 

system to wait before it considers the call unanswered. This option can be set in 

the ‘Continue Ringing’ edit box at the bottom of the screen. This setting will apply 

to all ‘No Answer’ rules. 

· Phone Busy - You will have to specify whether you want the phone or the PBX to 

do the busy signaling. By default, most SIP phones do not give a busy signal 

back, but accept a second incoming call. If you want to redirect a call when an 

extension is busy, you will need to specify “Use PBX status” in the busy 

detection list box. 

· Phone not registered – If the SIP phone has not registered with 3CX Phone 

System (i.e. is turned off), then the phone is considered unregistered and the 

rule will kick in 

· Forward all Calls – This rule will forward ALL CALLS 

· Based on Caller ID – You can handle calls from specific callers by specifying 

their caller ID. 
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3. You can now specify a particular time during which hours this rule must apply. You 

can configure the rule to be valid all the time (All Hours), during or outside office hours 

(Relies on system wide office hours setting) or during specific hours (In this case you 

can configure the specific hours using the ‘Specific hours’ button) 

4. Specify the Call Type - Whether this rule should apply to all calls, or only internal or 

external calls 

5. Specify the Action that the rule should take: 

· End Call 

· Forward to voice mail 

· Forward to extension –Specify the extension to forward to in the list box. 

· Forward to Outside number – In this case the system will forward the call to an 

outside number. Be sure to include the complete dial string including the prefix. 

· Forward to Queue / ring group – Specify the virtual extension number of the ring 

group or Queue in the list box 

· Forward to Digital Receptionist – Specify the virtual extension number of the 

digital receptionist in the list box. 

5. Once you have filled out all necessary fields, click on the ‘Add’ button to create the new 

rule. You can order the priority of the rules by moving rules up or down. The first rule that 

meets the conditions will be triggered! 

Importing extensions 

If you need to create a  large number of extensions it is handier to bulk import the 

extensions. To do this, create a spreadsheet with columns for each field that you wish to 

import. Please find a detailed description of fields as well as a link to a sample import file 

at 

http://wiki.3cx.com/Home/faq/import-extension-list 

Grouping & Assigning Rights (for 3CX Assistant) 

It is possible to group extensions. This serves 2 purposes – firstly it helps displaying and 

organizing the extensions, and secondly you can use groups to configure what 

information is to be shown to whom in 3CX Assistant. To create an extension group: 

http://wiki.3cx.com/Home/faq/import-extension-list
http://wiki.3cx.com/Home/faq/import-extension-list
http://wiki.3cx.com/Home/faq/import-extension-list
http://wiki.3cx.com/Home/faq/import-extension-list
http://wiki.3cx.com/Home/faq/import-extension-list
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Screenshot 8 - Adding an Extension Group 

1. Click on the Extensions node and click on the ‘Add Extension Group’ icon. 

2. Now proceed to add Extensions by selecting extensions and clicking on the ‘Add 

button. Note that Extensions can only be part of one group, so only extensions that have 

not been assigned to a group yet are listed. 

 

Screenshot 9 - Setting Extension Group Rights 

3. Now click on the ‘Rights’ tab. These settings pertain to what group members can see 

and do in the 3CX Assistant. 

4. You can configure one or more ‘Administrators’ for this group. Typically this would be a 

department supervisor. Group administrators will be able to see the call details of 

everyone WITHIN that group. 

5. •Optionally you can enable the Administrator extensions to perform operations on calls 

of any of the group members. Check the option “Perform operations on calls to users of 

this group” to enable this. 

6. You can also configure what rights regular group members have: 
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· See Call Details of other group members 

· See incoming calls to other group members 

· Perform operations on calls of group members. 

7. Click OK to save group and rights information. Users will need to login and logout of 

3CX Assistant to see their new rights reflected. 

The Management Extension group 

The Management Group is a group that is always present in 3CX Phone System. 

Extensions assigned to this group can: 

· See the call details of all extensions and queues 

· Perform operations on any call in the system (Pickup, transfer, Divert, Reject, 

Park). 

To add an extension to the management group: 

1. Click on the MANAGEMENT sub-node under the extensions node.  

2. Select an extension and click Add. Press Apply/OK to save the changes. 

3. Now logout and login with 3CX Assistant to see the additional information. 





 
 3CX Phone System for Windows System for Windows www.3cx.com 

 

Page 33 

4. Adding PSTN line(s) via a VOIP Gateway 

Introduction 

External calls are received and made on PSTN phone lines. A traditional PBX requires 

you to connect the PSTN lines to the PBX hardware box; however in the case of 3CX 

Phone System you have more options: 

· Connect PSTN lines ( physical phone lines) to a VoIP Gateway situated on your 

internal network. 

· Connect PSTN lines to a VoIP add in card, such as a Sangoma, installed on the 3CX 

Phone System machine or on another machine. 

· Use a ‘hosted’ phone line from a VOIP Service Provider. In this case the VOIP service 

provider has connected external lines to a VOIP Gateway and allows you to access 

these lines via your internet connection. 

To make & receive external phone calls via your regular phone lines, you will have to buy 

and configure a VoIP gateway or VoIP add in card. This chapter explains what they are 

and how to configure them. 

What is a VoIP Gateway or VoIP add in card? 

A VoIP gateway is a device which converts telephony traffic into data, so that it can be 

transmitted over a  computer network.  In this manner PSTN/telephone lines are 

“converted” to SIP extensions, allowing you to receive & place calls via the regular 

telephony network. VOIP Gateways exist for analog lines as well as BRI, PRI/E1 lines 

and T1 lines. VoIP cards do the same thing, but are add in cards that are installed into an 

existing computer. 

There are lots of VoIP gateways and VoIP cards available today at competitive prices. 

Analog VOIP gateways start for as little as $100. Be sure to use a supported gateway - a 

list of supported gateways & cards can be found on http://www.3cx.com/voip-

gateways/index.html. 

PSTN line configuration overview 

Just as it is necessary to configure a phone to register with the phone system, it is 

necessary to configure the VoIP gateway or card to register its lines with 3CX Phone 

System. Each port gets a SIP user ID & Password, and to the IP PBX, the PSTN line 

appears just like any other SIP extension.  

In the next sections we will now describe step by step how to configure a VOIP Gateway 

for use with 3CX Phone System. 

http://www.3cx.com/voip-gateways/index.html
http://www.3cx.com/voip-gateways/index.html
http://www.3cx.com/voip-gateways/index.html
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Definitions 

In this manual and in the 3CX Phone System Management Console a number of terms 

are used: 

Port – a port is a physical port on a gateway or VoIP card. In the case of an analog line, 

one port equals one PSTN line. In the case of BRI ISDN, one port is 2 PSTN lines, and in 

the case of E1 or T1 ports, each port represents 30 and 23 lines respectively. 

Virtual Extension Number – this is an extension number assigned to a port. This virtual 

extension number is used by the port, together with the authentication ID and the 

authentication password, to register with 3CX Phone System.  

Port identification – this is a field used to identify the port. You can enter the PSTN line 

number here, or simply a text string such as ‘sales’ 

Step 1: Create the PSTN gateways in 3CX Phone System  

The first step is to create the PSTN gateway in the 3CX management console.  

 

Screenshot 10 – Choosing gateway template 

1. In the 3CX Phone Management console menu click on Add > PSTN Gateway.  

2. In the name field, enter a friendly name for the VOIP gateway. Now choose the 

gateway model that you are using from the list. If it is not listed, select generic. Note 

that we will not be able to support you in using this gateway. Now click “Next”. 
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3. Enter the host name or IP of the VOIP Gateway in the ‘Gateway Hostname or IP’ field, 

and specify the SIP Port on which the gateway is operating. By default this is 5060. 

4. Specify the number and type of ports the gateway supports, i.e. analog, BRI, PRI or 

T1. This will set up one account for each port and enable the corresponding number 

of calls/lines for that account. An analog line supports 1 call; a BRI port supports 2 

calls, an E1 (PRI) 30, and a T1 (PRI) 23. For example, if you specify 1 * T1 port, it will 

create one SIP account which can handle up to 23 calls. If you wish to have each line 

individually addressed, simply select 23 * Analog lines. The other options, such as 

Registration Settings, Other options etc. have been preconfigured for your gateway 

model and do not need to be changed. Click Next to go to the next screen. 

 

Screenshot 9 - Adding PSTN Lines 

5. Click Next. The individual lines/ports will be ‘created’ and displayed in a columnar 

format.  

Virtual extension number – In effect the VOIP Gateway “converts” each line/port to an 

extension, so that the phone system can receive and forward calls to it. The virtual 

extension number is a number assigned to it by 3CX Phone System so that it can 

address it as an extension. There is no need to change this field. 

Authentication ID & Password: These values are used to authenticate the ports with 

3CX phone system. These values must match the settings configured in your 

gateway! By default the ID and password have been set to the Virtual extension number. 

Channels: The Channels field allows you to specify how many simultaneous calls this 

port supports. An analog line supports 1 call; a BRI port supports 2 calls, an E1 (PRI) 30, 

and a T1 (PRI) 23. If you prefer to address each line individually, you can create 

additional SIP accounts and change the number of channels supported by each account 

to 1. Note that your VOIP Gateway must support this – especially higher density VOIP 

Gateways are easier to configure if you use one account for all lines connected to a port. 

Port Identification – This field specifies the actual PSTN phone line number and is used 

for identification purposes only.  
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Inbound Route: If the port will receive inbound calls, you can specify to which extension, 

ring group or digital receptionist a call must be routed.  

6. On the next page, you will be asked for a prefix so as to create an outbound rule for 

this device. Enter the dialling prefix in the “Calls to numbers starting with (prefix)” text 

box. To make calls via this gateway, precede the number to be dialled with this prefix. 

Click Finish to create the lines. You can change line options of lines that have been 

created by going to the Lines node. 

Step 2: Configure the VoIP gateway 

After you have created the PSTN Lines/ports, a summary page will appear, which shows 

the information that you need to enter into the VOIP Gateway:  

· Proxy server IP or FQDN: Host name of 3CX Phone System 

· User ID: Virtual Extension number 

· Authentication ID: As specified in Authentication ID field 

· Password: As specified in Authentication password field 

The Virtual extension number, authentication ID and authentication password must be 

duplicated for each line/port that you have on your gateway. 

For a detailed description how to do this for popular gateways, follow the 

configuration guides listed on last page of the configuration wizard, or go to: 

http://www.3cx.com/voip-gateways/index.html 

Generating a configuration file 

For some gateways, 3CX Phone System is able to create a configuration file that can be 

uploaded to the device and makes configuration automatic. In this case, the button 

‘Generate config file’ button will be active. Clicking the button will generate a text based 

configuration file which can then be uploaded to the device using the web based interface 

of the device. 

Configuring the PSTN Interface 

In some cases you might need to check that the PSTN interface is configured correctly for 

your country. If in doubt, check with the VOIP Gateway supplier. For example if you have 

bought a device that is configured for the US but you are using it in the UK, you might 

have issues such as the device not detecting a hang up by a caller. In these cases you 

will have to configure the Call Progress Tones for the VOIP Gateway. For more 

information about this consult the VOIP Gateway supplier and manual. 

 

http://www.3cx.com/voip-gateways/index.html
http://www.3cx.com/voip-gateways/index.html
http://www.3cx.com/voip-gateways/index.html
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5. Adding lines hosted by a VOIP Provider 

Introduction 

VOIP providers “host” phone lines – they can assign local numbers in one or more cities 

or countries and route these to your phone system. In addition, VOIP providers are often 

able to give better call rates because they have an international network or have 

negotiated better rates. Therefore, using VOIP providers can reduce call costs. However 

be aware that each VOIP call requires bandwidth. VOIP is real time, so it does place a 

demand on your internet connection. As a rule of thumb, each call will consume 

approximately 30k-120k per second, depending on which codec you use. This chapter 

describes with which VOIP providers you can set-up an account and how to configure 

3CX Phone System accordingly. 

Requirements for using a VOIP provider 

If you plan to use a VOIP provider, you will have to have a firewall/router/NAT device that 

supports STATIC PORT MAPPINGS. Often routers will perform port address translation, 

which will cause problems such as one way audio, failing inbound calls and so on. It is 

also highly recommended that you have a static external IP. If your external IP changes 

at certain intervals, inbound calls will fail. Please see our support FAQs for more 

information and sample router configurations. 

Step 1: Create an account with a VOIP Provider 

To add a VOIP line you need to have an account with a quality VOIP service provider. 

3CX Phone System supports most popular SIP based VOIP service providers and we 

recommend using one that has been tested by 3CX. 3CX includes pre configured 

templates for these VOIP providers. Simply click on the ‘Add VOIP’ link to see a list of 

supported providers.  

Note that you can use any SIP based provider but we will not be able to support you in 

the configuration of the VOIP provider, nor can we guarantee that it will work. Therefore, 

unless for your country no VOIP provider is listed, use a supported VOIP provider. 

Step 2: Add the VoIP provider account in 3CX Phone System 

After you have created the VOIP provider account, you will need to configure the account 

in 3CX Phone System. To do this: 

1. In the 3CX Phone Management console menu, select Add > VoIP provider.  

2. Enter a friendly name for this VOIP provider account and choose the VOIP provider 

that you are using. If it is not listed, select ‘Generic VOIP provider’, or ‘Generic SIP 

Trunk’. A generic SIP trunk is a provider that does not use an authentication ID and 
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password, but rather uses your IP as authentication. If using a generic provider we will 

not able to guarantee that it will work with this VOIP provider. Click Next. 

 

Screenshot 11 - Add VOIP Provider account 

3. The registrar/Proxy Hostname will be pre-filled. Compare these with the details that 

you have received from your VOIP provider and check that these are indeed correct. 

Depending on the VOIP provider that you are using, some fields will be disabled. This 

means you do not need to change them. Click Next to continue. 

4. Now enter the VOIP provider account details. In the VOIP External number field, enter 

the VoIP line n umber that has been assigned to. Then enter the Authentication 

ID/user name and password of your VOIP provider account. Specify the number of 

simultaneous calls your provider supports. Click Next to continue. If you are using a 

SIP trunk, the authentication ID and password will be greyed out, since authentication 

is done via IP. 

5. Now specify how calls from this VOIP provider should be routed. You can specify a 

different route outside office hours. 

6. On the next page, you will be asked for a prefix so as to create an outbound rule for 

this VOIP provider.  Enter the dialling prefix in the “Calls to numbers starting with 

(prefix)” text box. To make calls via this provider, precede the number to be dialled 

with this prefix. 

Note: Frequently the internet facing firewall sitting between 3CX Phone System and the 

VOIP provider is not correctly configured or is not able to correctly route VOIP traffic. To 

check the firewall configuration, it is important to perform a firewall check using the inbuilt 

firewall checker. You can start it by going to the Settings > firewall checker node. It will 

connect with the public 3CX firewall check server (firewallcheck.3cx.com) and will check 
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that it can send and receive UDP data on port 5060 (for SIP), port 3478 (for STUN) and 

port 9000 to 9016 (for up to 8 simultaneous calls, default setting). If it can, the firewall 

check will succeed. If the firewall check fails, you will not be able to reliably make and 

receive VoIP provider calls and you will have to edit your firewall configuration. Note that 

we do not provide firewall configuration support.  

Specifying a STUN server 

Although 3CX includes a default STUN server setting, it is recommended that you specify 

the STUN server suggested by your VoIP provider as your default STUN server. First of 

all the STUN server suggested by your VoIP provider is probably closer to you and 

therefore quicker to reach (less hops). Secondly it’s probably a lot less. The faster the 

STUN server responds to requests, the quicker the call will be setup.  

To specify a different STUN Server: 

1. In the Management Console, go to Settings > Network node. Now click on the ‘STUN 

server’ tab. 

 

Screenshot 11 - Specifying STUN server 

2. In the edit box ‘Primary STUN server’ specify the STUN server suggested by your 

provider, for example stun.sipgate.net:10000 

3. You can specify an alternate backup server, or leave the stun2.3cx.com as the backup 

STUN server. This address will be used if the primary STUN server is down. Click OK to 

exit and save the settings. 

DIDs and VoIP providers 

If your VoIP provider has supplied you with DIDs, AND inbound call identification is based 

on destination/dialled number, it will be necessary to configure the Source Identification 

rules for the VoIP Provider. This is because the identification number will change 

depending on which DID number has been dialled. In this case you have the following 

options:  

1. If possible, consider using a different source identification rule, based on IP or on 

Authentication ID.  

2. Alternatively, enter all the possible DIDs associated with your account. If it is a large 

range, it is best to enter this as a mask using a wild card character (*). This helps 

improve system performance. For example, if you have a range of 999 DID 

numbers, eg 2456000 to 2456999, you can enter 2456* 
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Both options can be configured by editing the VoIP provider account and going to the 

“Source ID” tab. In the source ID tab you configure how inbound calls are identified. 

To create a different source identification rule: 

1. In the section “Call Source identification”, select the appropriate SIP field and the 

corresponding variable or value. 

To specify the DIDs associated with this account 

1. Enable the option “Source Identification by DID” 

2. Now specify the SIP field that contains the DID numbers 

3. Specify the DID numbers. ‘Add Mask’ allows you to add a mask that covers a 

range of DID numbers. Add DID number will bring up a dialog allowing you to 

select from DID numbers that you have already inputted in the DID tab of the VoIP 

provider. Click OK when done. 

Note: Configuration is necessary because source identification based on DID and routing 

based on DID are two different things and might require separate configuration. This is 

the reason it needs to be configured separately. 
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6. Creating Outbound Call Rules 

Introduction 

An outbound rule defines on which gateway/provider an outbound call should be placed, 

based on who is making the call, the number that is being dialled and the length of the 

number.  

Creating an outbound call rule 

 

Screenshot 12 - Creating a new outbound rule 

To create an outbound rule: 

1. On the 3CX Management Console menu, click Add > Outbound Rule, and enter a 

name for the rule.  

2. Now specify to what calls to apply the outbound route. In the ‘Apply this rule to these 

calls’ section, specify any of these options: 

· Calls to Numbers starting with – apply this rule to all calls starting with the number you 

specify. For example, specify 0 to specify that all calls starting with a 0 (usually a 

prefix) are outbound calls. Callers would dial ‘0123456’ to reach the number ‘123456’ 



 
 3CX Phone System for Windows System for Windows www.3cx.com 

 

Page 42 

· Calls from extension(s) – Select this option to define particular extensions or extension 

ranges for which this rule applies. Specify one or more extensions separated by 

commas, or specify a range using a -, for example 100-120  

· Calls with a Number length of – Select this option to apply the rule to numbers with a 

particular digit length, for example 8 digits. This way you can capture calls to local 

area numbers or national numbers without requiring a prefix.  

3. Now specify how the outbound calls should be made. In the ‘Make outbound calls on’ 

section, select up to 3 routes for the call. Each defined gateway or provider will be listed 

as a possible route. If the first route is not available or busy, 3CX Phone System will 

automatically try the second route. 

4. You can transform a number that has been ‘caught’ by the outbound rule before it is 

routed to the selected gateway or provider using the  ‘Strip digits’ and ‘Prepend’ fields: 

· Strip digits – allows you to remove 1 or more of the digits. Use this to remove the 

prefix before it is dialled on the gateway or provider. In the example above, you 

would specify to remove 1 digit, in order to remove the prefix ‘0’ before it is dialled. 

· Prepend – allows you to add one or more digits if needed by the provider or 

gateway. 

You can set these options per route, since a VOIP gateway connected to the local 

PSTN might require a different logic than if the call is routed via a VOIP provider. 

.
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7. The Digital Receptionist / Auto attendant 

Introduction 

The digital receptionist feature allows you to answer phone calls automatically using the 

computer and present the caller with a list of options. The caller can then choose the 

appropriate option using the numbers on his phone key pad.  

Using this feature you can implement a menu, for example: “for sales press 1, for support 

press 2 etc”. A digital receptionist is also known as an auto attendant. 

You can configure different menu options and text for the menus based on which line the 

calls comes in, as well as based on whether the call is received within or outside office 

hours. This way you could have a different answer outside office hours and de-activate 

menu options accordingly. 

Recording a menu prompt 

Before you create your digital receptionist, you must write down the menu options you 

wish to offer the caller, think of a suitable text and record the announcement. A simple 

example would be “Welcome to Company XYZ, for sales press 1, for support press 2 or 

stay on the line for an operator” 

Note: It is generally recommended to put the number the user should press after the 

option, i.e. “for sales, press 1”, rather then “press 1 for sales”. This is because the user 

will wait for the desired option and only then “register” what number to press 

Once you have devised the text you can create the prompt and save the file in wav or 

mp3 format. For best performance, it is best to save the prompt in PCM, 8 kHz, 16 bit, 

Mono format. Windows Sound Recorder supports creation and conversion of this format. 

Recording the prompt in Windows Sound Recorder 

To record the prompt in Windows Sound Recorder: 

1. Start Windows Sound Recorder from the Start > Programs > Accessories > 

Entertainment group. This program should be installed by default on Windows. 
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Screenshot 13 - Windows Sound Recorder 

2. Now click the record button to record your system prompt. 

3. Now save the file using the ‘Save As’ command. This allows you to specify the format 

to save the file in. Click on the ‘Format’ button to change the format to PCM, 8 kHz, 16 bit.  

Enter a name for the prompt and click save. 

4. When creating a digital receptionist menu you will be asked for the path to the file.  

Note: You can also have your voice prompts professional recorded using a Voice Talent 

studio. Be sure to have them created in the specified format. 

Creating a digital receptionist 

You can create multiple digital receptionists and link them to a particular line. To create a 

digital receptionist: 

1. In the 3CX Phone System Management Console menu, select on Add > Digital 

Receptionist.  
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Screenshot 14 - Configuring a digital receptionist 

2. Specify a name and virtual extension number for the digital receptionist.  

3. Now click on the browse button and specify the file that you previously recorded. The 

file will be copied into the 3CXPhone System\Data\Ivr\prompts\ directory. 

4. Specify the menu options. Select the appropriate key, and then select from the 

available actions. Then specify the extension number or virtual extension number (virtual 

extension number in the case of Ring Group, Call Queue or to another Digital 

receptionist) 

5. The last option, Timeout, allows you to specify how long the system should wait for an 

input. If it receives no input, it will automatically perform this action. This is handy for 

callers who did not understand the menu or who do not have a DTMF capable phone. 

When you are ready, click OK to save the digital receptionist. 

Allowing callers to dial a known extension directly 

Whilst a digital receptionist prompt is playing, a caller can enter the extension number 

directly to be connected to an extension immediately. This allows callers who know their 

parties extension to avoid bothering the receptionist. 

This option is enabled by default. If you wish to make use of this feature simply instruct 

your callers by explaining this in the voice prompt. For example: 
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“Welcome to Company XYZ, for sales press 1, for support press 2. If you know your 

parties extension number, you may enter it now” 

Call By Name 

You can also direct callers to the dial by name function. This allows them to find the 

person they wish to speak to by entering the first letters of the persons name on the 

phone dial pad.  

Requirements: 

To call to a user using the call-by-name mechanism you have to: 

1) Define a self-identification message for the user. Users without a self-identification 

message are not accessible via call-by-name mechanism. 

2) User has to have the last name without Unicode characters  

3) Call-by-name menu dialog can be activated from any Digital Receptionist as an action 

on key pressing or timeout. 

Self-identification Message 

To enter self-identification message: 

1) Activate Special Menu for your extension. 

2) Go to the options menu (‘9’ key). 

3) Press ‘5’ key. 

If you do not have self-identification message yet, then you will hear “Record your self-

identification message, then press pound”. If you already have a self-identification 

message, then you will hear “To record new self-identification message press zero. To 

delete message press one. To exit press pound.” 

Calling 

Call-by-name mechanism uses the last name of the user to compare with call-by-name 

input (that has been entered from phone keypad). The following rules are used: 

· The last name is converted to upper case. 

· All symbols except [2-9] and [A-Z] are ignored. 

· The following translations for symbols is used: 

o 'ABC2' => '2' 

o 'DEF3’ => '3' 

o 'GHI4' => '4' 

o 'JKL5' => '5' 

o 'MNO6' => '6' 

o 'PQRS7' => '7' 
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o 'TUV8' => '8' 

o 'WXYZ9' => '9' 

You have to type a minimum of three digits (‘0’ – ‘9’) to call to a user. Digits ‘0’ and ‘1’ are 

ignored, but can be used to call to users with short last names (for example, to access 

someone with the last name ‘Li’, you can type ‘540’). 

After the user has entered three digits, IVR queries the phone system database for 

matching users. If there are no matching users, then it plays “extension not found”. If 

there is only one matching user, then the IVR plays “Please hold while I’m calling to 

<user’s self-identification prompt>” and redirects the call to the user. If there is more than 

one matching user, than IVR waits for additional digits from user for 2 seconds. 

If IVR waits for additional digits (more than one matching user) and user press any digit, 

then IVR adds this digit to the current input and checks currently matching users. If there 

are no matched users, then it plays “extension not found”. If there is only one matching 

user, then the IVR plays “Please hold while I’m calling to <user’s self-identification 

prompt>” and redirects the call to the user. If there is more than one matching user, than 

IVR waits for additional digits from user during 2 seconds. 

If user terminates input (2 seconds elapsed or ‘#’ has been pressed) and more then one 

user is matching, then IVR will play something like: “To call to Van Damme press 0. To 

call to Van Hallen press 1. To exit press pound”. Here ‘Van Damme’ and ‘Van Hallen’ are 

self-identification prompts of the corresponding users. 
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8. Adding Direct numbers using DID/DDI lines 

Introduction 

Many companies provide users and/or departments with “Direct or DID numbers”, which 

allow their contacts to call them directly, bypassing the receptionist. DID numbers are 

referred to as DDI numbers in the United Kingdom and as MSN numbers in Germany. 

Even if you have a digital receptionist, a direct line / number is often preferable because 

it’s more convenient for the caller. 

Direct numbers can be easily implemented using DID numbers. DID numbers are 

provided by your VOIP provider or Phone Company and are virtual numbers assigned to 

your physical lines. Usually you are assigned a range of numbers, which is linked to an 

existing BRI/T1/E1. There will be an extra charge per number or per range, but this will be 

a fraction of the cost of adding physical lines. VOIP providers also provide DID lines. 

Enquire with your Phone Company or VOIP provider for more information. 

DID numbers and 3CX Phone System – How it works 

DID numbers “play well” with 3CX Phone System, or indeed with any SIP based IP PBX. 

Acting according to the SIP standard, 3CX Phone System expects the DID number, i.e. 

the intended destination, to be in the To: field of the SIP invite request. Most VOIP 

providers and VOIP Gateways will do this by default. Then all you need to do in the 3CX 

Management Console is to configure calls made to that particular DID number to go to a 

particular extension, digital receptionist or other destination. 

Adding DID’s 

To add a DID; 

1. Go to the VOIP provider account or VoIP Gateway node via which the DID’s are 

routed. Select the VoIP Gateway or provider and click Edit. Now go to the ‘DID’ tab and 

enter all the DID’s that you have been assigned.  
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Screenshot 12 - Adding DID numbers 

Note: Enter the DID number as it will appear in the SIP “to” header. 3CX Phone System 

will match the number inserted in this field with the “to” header, starting from the last part 

of the received string, thus avoiding any differences in the format of the number. For 

example, if you are based in the UK and your DID number is 0845-2304024, then you can 

enter the number 2304024. This will match any DID number inserted in the “To” field 

ending with these numbers, including +448452304024, 08452304024, 00448452304024, 

and, of course, 2304024. Of course it is best to check with your VoIP provider or Phone 

Company in what format the DID number will be inserted just for reference. 

2. For each DID that you add, an inbound rule will be created. You can configure how 

calls to these DID’s should be routed by going to the Inbound rules node and double 

clicking on the DID. Click OK to save the DID’s. 

Note: If you are adding DID’s for a gateway with multiple ports, you must select for which 

port the inbound rule must be created. 
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Screenshot 13 - Selecting where to route calls to this DID 

3. After you have entered all the DID’s, click on the Inbound Rules node. All the newly 

created DID’s will be listed as inbound rules. Double-click on any of them to c onfigure 

how to route inbound calls to this DID: 

· End Call 

· Connection to extension 

· Connect to Queue/Ring Group 

· Connect to Digital receptionist  

· Voicemail box for extension 

· Forward to outside number 

· Send fax to email of extension 

Route inbound calls out of office hours: 

You can specify that an incoming call is routed differently if it is received outside office 

hours. De-select the ‘Same as during office hours’ option to specify a different route. 

Troubleshooting DID lines 

If you have created DID lines, but calls are not being forwarded, its best to do the 

following: 

1. Go to the Server Activity log node in the 3CX management Console. The Server 

Status screen lists current server activity and logs calls that are being received and for 

which number they were received.  

2. Call the DID number that you configured, and monitor the Server Status log. You will 

see a line appearing something like: 

Incoming call from 1000 to <sip:789456123@3CXPhone System>  

where “1000” is the internal number of the line configured to receive calls from the 

VOIP Gateway or VOIP Provider and <sip:789456123@3CXPhone System> is the 

content of the “To” header of the INVITE, i.e. the intended recipient. 
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3. Now analyze the “To” header carefully and ensure that the DID number you have 

dialled is present in the “To” header: <sip:789456123@3CXPhone System>. 

4. If the DID number is not present in the “To” header, you will have to check the 

documentation of your VOIP Gateway to find how you can configure it to insert the 

DID number into the “To” field. In the case of a VOIP Provider, contact your VOIP 

provider for more information.  

5. If the DID number is present in the “To” header, check whether the string listed in the 

“To” field matches the string you configured in the rule. Adjust accordingly and try 

again
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9. Ring groups, Call Queues, Paging / Intercom 

Ring Groups 

A ring group allows you to direct calls on particular numbers to a group of extensions. For 

example, you could define a group of 3 sales people, and have the general sales number 

ring on all 3 extensions at the same time or after each other. When you create a ring 

group, you also assign it a virtual extension number. This will be the number used by the 

phone system to “address” the ring group. 

 

Screenshot 16 - Adding a ring group 

To add a ring group: 

1. In the 3CX Phone Management console menu, select Add > Ring group.  

2. Now enter the ring group options:  

· Virtual extension number – Specify an extension number which will be reserved for 

this ring group. Note that this extension number will be automatically created. Do not 

specify an existing extension number. 
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· Name – Enter a friendly name for the ring group 

· Ring strategy – Select the appropriate ring strategy for this ring group:  

o Hunt – this will start ringing on the first extension, then the second etc. 

o Ring all – all phones will ring at the same time 

o Paging – this will page all extensions part of the group (see next section) 

· Ring time – Specify how long the phones should ring for. 

3. In the section ‘Ring group members’ specify the extensions that should be part of this 

ring group. Simply click on the extensions and click on the -> to make them a member. 

Move the extensions up or down to configure the priority of an extension. 

4. In the section ‘Destination if no answer’, you can define what should happen if the call 

does not get answered by the ring group. 

Paging / Intercom (Paid editions only) 

Paging allows some one to ring a group of extensions and make an announcement via 

the phone speaker. The called party will not need to pick up the handset. The connection 

will be one way audio. 

The intercom feature allows a phone system user to make an announcement to a single 

extension. In this scenario the audio is two way, and the called party can respond 

immediately without picking up the handset.  

Both paging and intercom features require a phone that supports intercom and that is 

configured to allow it. See the phone configuration guides for more information. 

To add a paging group: 

1. Click on the Add > Ring Group menu option to bring up the ‘Add Ring Group’ page.  

2. Now enter the ring group options:  

§ Virtual extension number – Specify an extension number which will be used 

for this paging group.  

§ Name – Enter a friendly name for the ring group 

§ Ring strategy – Select the Paging ring strategy 

3. In the section ‘Ring group members’ specify the extensions that should be part of this 

paging ring group. Simply click on the extensions and click on the -> to make them a 

member.  

Note, The ‘Ring time’ and ‘Destination if no answer’ options will be ignored, since they are 

not relevant for paging. 

To call a user via the intercom function: 

Prefix the extension you wish to call with *9, followed by the extension. For example to 

make an intercom call to extension 100 you should dial: 

'*9100' 
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Call Queues (Paid editions only) 

Call Queues allow calls to be queued whilst agents (members of a call queue) answer 

calls. Calls do not go unanswered but are queued until an agent is available to take the 

call. For example, you can define a group of 3 sales people, and have the general sales 

number route to a sales call queue. If all 3 sales people are busy, callers will be kept on 

hold until the next sales person is free. When you create a call queue, you also assign it a 

virtual extension number. This will be the number used by the phone system to “address” 

the Call Queue. 

 

Screenshot 17 - Adding a Call Queue 

To add a Call Queue: 

1. Click on the Add > Call Queue menu option to bring up the ‘Add Call Queue’ page.  

2. Now enter the call queue options:  

· Virtual extension number – Optionally change the suggested virtual extension number. 

Note that this extension number will be automatically created. Do not specify an 

existing extension number. 
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· Name – Enter a friendly name for the ring group 

· Ring time – Indicate the time out, i.e. for how long the phone should keep ringing 

before it considers the call unanswered by that agent. 

3. In the section ‘Call Queue agents’ specify the extensions that should be part of this Call 

queue. Simply click on the extensions and click on the -> to make them a member. Move 

the extensions up or down to configure the priority of an extension. 

In addition to being a member, an extension/user must also login to start 

answering calls routed to this call queue. Users can login to a call queue using the 

login button in the VOIP Client. 

4. In the section ‘Destination if no answer’, you can define what should happen if the call 

does not get answered by an agent. If no agent is logged into the queue, this option gets 

triggered immediately. In addition, this option gets triggered if the user presses the ‘*’ 

button on his phone. This allows you to give callers an option to exit out of the queue and 

leave a message. 

5. In the section ‘Other options’, you can specify a custom introduction prompt and a 

custom music on hold file. You can also decide whether you wish to announce a caller’s 

position in the queue and what the maximum wait time should be.
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10. Call conferencing 

Introduction 

Note: This feature is not present in the free edition of 3CX Phone System 

Call conferencing allows you to easily setup up to 8 conference calls that can allow a total 

of 32 callers (license permitting). In other words the 32 caller limit is for all conferences, 

not per conference. Note that a conference with 32 participants will require a powerful 

machine. 

Although many conference call services exist, it’s often easier and cheaper to host your 

own audio conferences.  

Conferences can be set-up ad hoc, without the need to reserve a conference room. This 

has been done to simplify the set-up of conference calls. 

Enabling conferencing 

The conferencing service does not require much configuration – you just need to specify 

the default conference extensions. To do this: 

1. In the 3CX Management console, open the Settings > Advanced node and click on the 

Conferencing tab. 

2. Now specify the conferencing extension number. This is the number that users must 

call to setup a conference. 

3. Specify the maximum number of conferences you wish to support. By default 4 

conferences can be held at a time. 

Creating a call conference 

To setup a call conference; 

1. Dial the conference extension number, by default this is 700 

2. You will be requested to enter a conference ID. This can be any number, for 

example ‘100’. All callers that wish to join the conference must use the same 

conference ID! 

3. If you are the first participant, the conference system will ask you to confirm creation 

of the conference. Press * to confirm or # to cancel 

4. You will be asked to speak your name after the beep and press a button to continue. 

5. You will now enter the conference. If you are the first caller, you will hear music on 

hold, whilst you wait for the other callers. As soon as another caller joins, his name 

will be announced. 
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11. Generating Call Reports 

Introduction 

 

Screenshot 14 - Call Reports 

3CX provides a number of reports via its 3CX Call Reporter utility. This utility can be 

started from the 3CX Phone System program group. 

Reports available 

After you have started 3CX Call Reporter, you can access the following reports from the 

reports menu at the top: 

· Call Logs Report 

· Call Statistics 

· Queue Statistics 

· Abandoned Calls 

· Agent statistics 

· Ring Group Statistics 
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12. Connecting 3CX Phone Systems 

Introduction 

Note: This feature is not present in the free edition of 3CX Phone System 

You can connect 2 separate 3CX Phone Systems or a 3CX Phone System with another 

SIP phone system using a bridge, allowing you to make calls between branch offices 

using your internet connection – and thus at no charge.  

The “bridge” will be assigned a prefix, which users must dial to access the other 3CX 

Phone System or SIP phone system. This prefix must be followed by the extension 

number of the user they wish to reach on the other 3CX Phone System. For example, if 

you assign the prefix “2” to a bridge with another office, and within that office you want to 

dial someone who has extension number 105 on that phone system, you would dial 2105 

to reach that person directly. 

Creating a bridge 

To create a bridge: 

1. Click on the Add > Bridge menu option to bring up the ‘Add Bridge’ page.  

2. Enter a name for the bridge and assign a virtual extension number. A bridge must be 

assigned a virtual extension number so it can be addressed by the phone system. Accept 

the default or choose another extension that is free. 

3. Now select the Type of bridge: 

· Master (Direct (UDP) - If you select ‘Master’, the other PBX must register with this 

system. In Direct (UDP) mode, all traffic will be sent via UDP and will use multiple 

ports 

· Master (Tunnel (TCP) ) - If you select ‘Master’, then the other PBX must register 

with this system. The tunnel option allows all SIP and RTP traffic to be sent via a 

single TCP port. The 3CX Tunnel vastly simplifies firewall configuration, although 

it can not provide the same quality as a direct connection. Also, the tunnel option 

can only be used against another 3CX Phone System. 

· Slave (Direct (UDP) – This system will register with the remote system using direct 

SIP.  

· Slave (Tunnel (TCP) ) – This system will register with the remote system using the 

3CX tunnel. 
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Screenshot 15 - Creating a master bridge 

4. If you selected ‘Master (Direct (UDP)’ then all you need to do is enter the 

authentication details which must be used by the slave to register with this 3CX Phone 

System. The authentication ID must be UNIQUE on this phone system and these 

same credentials must be used by the slave bridge. 

5. If you selected ‘Master (Tunnel (TCP) )’ then you must enter 

· Authentication ID and Password –The authentication ID must be UNIQUE on the 

phone system and these same credentials must be used by the slave bridge. 

· Remote end of the tunnel – Enter the public IP of the REMOTE 3CX Phone System 

machine.  

· Enter the remote port of the 3CX Tunnel (by default 5090) 

· Enter the port of the Local end of Tunnel. For the first bridge connection it is 5081 

(5080 is used for external extensions). The port will be incremented by 1 for each 

bridge you create that uses the tunnel. 

 

Screenshot 16 - Configuring a slave bridge 

6. If you selected to create a slave bridge using direct UDP, then you must enter: 

· Public IP of the remote 3CX Phone System   

· SIP Port of the remote 3CX Phone System 
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· Authentication ID and Password – The credentials with which this side of the bridge 

must authenticate with the ‘Master’. These must of course match the credentials 

entered on the master. 

 

Screenshot 21 - Slave bridge using 3CX Tunnel 

7. If you have selected to create a slave bridge using a 3CX Tunnel, then you must enter 

· Local IP or hostname of remote 3CX Phone System and port 

· Remote end of the tunnel – in most cases the tunnel will be running on the 3CX 

Phone System machine, in which case you need to enter the public IP of the 3CX 

Phone System machine. Enter the remote tunnel port of the 3CX Tunnel (by default 

5090) 

· Enter the Local end of Tunnel. Leave the default ‘Localhost’ and 5081 to use the 

Tunnel installed by default with 3CX Phone System. The port will be incremented 

with each bridge that you create that uses the tunnel. 

· Authentication ID and Password – Enter the credentials with which this side of the 

bridge must authenticate with the ‘Master’. These must of course match the 

credentials entered on the master. 

Note: You will have to open port 5090 on the firewall behind which ‘Master’ 3CX 

Phone System resides. 

8. Now you must assign a prefix that users must dial to access the bridge. Click Next to 

create the bridge. 

9. After it is created it, you can edit bridge options by going to the bridges node. You can 

edit: 

· In the section other options you can define the maximum number of simultaneous 

calls you will allow for this bridge and whether outgoing or incoming lines will be 

allowed. 

· Configure what to do with calls coming in via the bridge outside office hours 
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10. Now you must go to the Management Console of the other 3CX Phone System and 

set-up the opposite end of the bridge, i.e. either a ‘Master’ or a ‘Slave’. You must use the 

same authentication credentials!  

Calling a party on the other 3CX Phone System 

To dial a party at the connected 3CX Phone system, you must dial the assigned prefix, 

plus the extension number of the person you wish to call. 
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13. Backup and Restore 

Introduction 

3CX Phone System includes a convenient backup and restore function, that allows you to 

create a complete backup of your phone system configuration to a file. To backup data, 

run the Backup and Restore utility located in the 3CX Phone System Program group. 

To restore phone system data, locate the backup of the phone system data and click 

‘Restore’. Note that the current configuration will be OVERWRITTEN with the backup 

data, and any changes that you have made since performing the backup will be lost. 

Running backup & restore from the command line: 

Note: Close the management console BEFORE making a restore.  

3CXBackup /hidden  backup / restore filepath [/? | | /history | /prompts | /recordings 

Where 

/hidden runs the process hidden so it will close automatically after completion 

Backup will backup the database 

Restore will restore the database 

Filepath is the location of the database to restore from or backup to 

Options 

/? Is this help message 

/history will include the call history database 

/prompts will include all system prompts 

/recordings will include all call recordings. 

Example 

3CXBackup /hidden backup c:\data\3cxbackup.zip /call history /prompts 

/recordings 

Scheduling backup & restore 

Using the Windows scheduler you can easily schedule a daily phone system backup. To 

do this: 

1. Go to Start > Accessories > System tools > Schedule Tasks 

2. Double-click on ‘Add Scheduled task’ 

3. Browse to the 3cxbackup program , 3cxbackup.exe 

4. Specify schedule and account to use. 
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5. After it is created, you have to modify the schedule to include the command line 

parameters that you need. 

Backing up call logs 

3CX Phone System v7 separates backup of call logs from backup of phone system 

configuration data. There is a separate utility to backup the call logs and the actual 

backup output is located in 2 different files called, called (callhistory2.txt, calldetails.txt). 

The callhistory2x.tst contains the calls and the calldetails.txt file contains further 

information on each call (transfer, queue info etc.) Each time the utility is run, it will 

overwrite the last export of data with the newest one. 

To perform a backup of the call data: 

1. Go to the c:\program files\3cx phonesystem\bin folder 

2. Run CallLogBackup.exe. and specify the –backup parameter and a path to place the 

files, e.g.  ‘C:\>CallLogsBackup.exe -backup "C:\My Call Logs"’ 

3. The program will start exporting the Call data to location specified.  

4. You can add a Scheduled task in Windows to run this task Daily, for example at night. 

The utility has 2 other switches: /restore and /purge. The restore switch should ONLY be 

used to restore call log data to a new database that does not already have the same call 

log data. To restore data, specify the restore flag and location of backup logs, e.g. 

CallLogBackup.exe -restore "C:\My Call Logs" 

The purge function allows you to delete all call log data IN THE DATABASE, and 

obviously should be used with care. 
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14. Fax server 

Introduction 

Note: This feature is not present in the free edition of 3CX Phone System 

3CX Phone System includes a fax server that allows the whole network to send and 

receive faxes. The 3CX fax server is based on the T38 standard and requires a 

compatible T38 VOIP gateway. It is possible to use a VoIP provider also, however in 

many cases the T38 implementation is not correct and therefore we can not support this 

configuration. 

Note that to use fax you must use a supported gateway and it must be configured 

according to our configuration guides, so that fax reception is enabled. 

Sending faxes overview 

Faxes are sent using the fax client built into all Microsoft Windows versions. The 

Microsoft fax client is feature rich and seamlessly integrated into Microsoft Office and 

Windows.  

For all network clients to send faxes via Microsoft Fax, you will to need to install the 

network fax server component of Windows 2003 / 2008 server. 3CX Fax Server 

integrates with the Microsoft Network Fax server service by installing a T38 fax driver. 

This T38 fax driver talks to the 3CX Fax server which sends out the fax via the VOIP 

Gateway or VOIP provider. 

Receiving faxes overview 

The receiving of faxes is completely handled by 3CX Fax Server. Faxes are forwarded to 

the 3CX Fax Server which receives the fax, converts it to PDF and then emails the fax to 

the configured email address. You will need to dedicate a DID or line to fax and route all 

calls on this line to the 3CX Fax Server extension.  

Fax receiving configuration 

To receive faxes, you have to configure one of the lines or DID’s (if you don’t want to 

dedicate a line) on your VOIP Gateway to be a fax line, and forward all calls on this line to 

the Fax server extension. The Fax server will then receive the fax and forward the fax as 

an email. 
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Screenshot 17 - Configuring a port or DID to receive a fax 

To do this: 

1. In the Management console, select the port or DID which will be dedicated to receiving 

faxes. 

2. Now configure calls to on this line/did to go to ‘Send fax to email of extension’. 

3. Select to which email address you want to email the received fax. If you select “Default 

FAX Destination”, the fax will be sent to the email address configured for the virtual fax 

extension number. Alternatively you can forward faxes to the email address configured for 

a particular extension. This allows you to create multiple DID rules so as to give people a 

personal fax extension. You can configure the default email address from the settings > 

fax node. 

Fax sending configuration 

To send faxes, you need to install and configure Microsoft Fax. To do this, follow these 

steps: 

Step 1: Install Microsoft Fax Server 

Select a Windows 2003 or 2008 server that will act as the fax server. This does not have 

to be a dedicated machine, and it does not have to be (but can be) the same machine as 

3CX Phone System. This machine will just have Microsoft Fax installed and the system 

load will be minimal, comparable to a print queue. The 3CX Microsoft Fax server driver 

can communicate easily with a remote 3CX Phone System. 

To install the Microsoft Fax Services on Windows 2003, follow this link for detailed 

instructions: 

http://www.3cx.com/support/microsoft-fax-services.html 

To install the Microsoft Fax Services on Windows 2008, follow this link for detailed 

instructions: 

http://www.3cx.com/support/microsoft-fax-2008.html 
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Step 2: Install the 3CX Microsoft Fax driver 

1. Download the fax server send module f r o m  the 3CX web site: 

http://www.3cx.com/downloads/3CXfaxserver.msi 

2. STOP the Microsoft Fax service from the services control panel applet before you run 

the 3CX Fax server installation.  

3. Now double-click on the setup file  to start the installation.  

4. You will be prompted to specify the IP or host name of the 3CX Phone System 

machine, as well as the port name. Specify the hostname or IP of 3CX Phone System 

and leave the port default at 5487. If 3CX Phone System is installed on the same 

machine, specify ‘Localhost’ 

5. Setup will copy the files 

6. Now go to the Windows services applet and start the Microsoft Fax Service 

Step 3: Configuring Microsoft Fax to use the 3CX Fax server driver 

Configuring Microsoft Fax on Windows 2003: 

1. Go to the Microsoft Fax console (Start > Programs > Accessories > Fax > Fax 

console 

2. Launch the Fax configuration wizard by going to Tools > Configure fax 

3. Specify default company information. 

4. Specify your dialing location. Be sure to include any prefix that needs to get dialed to 

get an outside number on the PBX! 

 

Screenshot 18 - Selecting 3CX as the fax device 

http://www.3cx.com/downloads/3CXfaxserver.msi
http://www.3cx.com/downloads/3CXfaxserver.msi
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5. Now select 3CX Fax Device 0 as the device to send faxes. Click Next. 

6. Specify the outbound Fax ID to be used for your company 

7. In the next step, do not select 3CX Fax Device for inbound faxes. This is not yet 

supported. For now faxes are received direct to email as PDF files 

 

Screenshot 19 - The 3CX Fax driver installed 

8. Click Finish. 3CX Fax is now installed and configured. To check this startup the 

Microsoft Fax Service Manager. You will see the 3CX Fax Device appear as one of 

the fax devices. 

9. You are now ready to send faxes. You can send a test fax from the File menu of the 

Fax Console. For information how to use Microsoft Fax, see its help function. 

Configuring Microsoft Fax on Windows 2008: 

1. Open Server Manager and expand the Fax Server tree display. Under Devices and 

Providers you will see the 3CX Fax Device as the Fax Sending Device for Outgoing 

faxes. In the Devices section and in the Providers Section, you will also see the 3CX 

Fax Service Provider.   

 

Screenshot 20 - 3CX Fax driver in Windows 2008 

2. Go to the Rules Section and specify the 3CX Fax Device 0 as the Target Device from 

the drop down list. Microsoft Fax is now configured. 
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Screenshot 21- Selecting 3CX Fax Device as the default target 

Step 4: Install the Fax clients 

If you have not yet installed the Microsoft Fax clients, you have to install them on the 

individual client machines and configure them to connect to the central network fax 

server. This is a simple process and well documented in the Microsoft Help Files. Note 

that these are the standard Microsoft Fax clients; they have not been modified by 3CX in 

any way. 

To install the fax client on Windows XP, follow this link for detailed instructions 

http://www.3cx.com/support/Windows-xp-fax-client.html 

To install the fax client on Windows Vista, follow this link for detailed instructions 

http://www.3cx.com/support/Microsoft-vista-faxclient.html 

Changing the Fax Server Credentials 

The Fax server operates as a virtual extension and logs into the SIP server just as an 

extension would. It uses an authentication ID and password which is set to 888 by 

default. To change the authentication ID and password: 

1. In the 3CX management console, go to the Settings > Fax node 

2. In the ‘Fax Server Extension Number’ field, specify the fax extension number. Any call 

forwarded to this extension will be assumed to be a fax and receive a fax tone. 

http://www.3cx.com/support/Windows-xp-fax-client.html
http://www.3cx.com/support/Windows-xp-fax-client.html
http://www.3cx.com/support/Windows-xp-fax-client.html
http://www.3cx.com/support/Windows-xp-fax-client.html
http://www.3cx.com/support/Windows-xp-fax-client.html
http://www.3cx.com/support/Windows-xp-fax-client.html
http://www.3cx.com/support/Windows-xp-fax-client.html
http://www.3cx.com/support/Microsoft-vista-faxclient.html
http://www.3cx.com/support/Microsoft-vista-faxclient.html
http://www.3cx.com/support/Microsoft-vista-faxclient.html
http://www.3cx.com/support/Microsoft-vista-faxclient.html
http://www.3cx.com/support/Microsoft-vista-faxclient.html
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3. Specify the Fax Server Authentication ID and Password – These credentials will be 

used by the fax server to login to the SIP server. 

Please note that you must restart the fax service for changes to take effect. 
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15. Monitoring your Phone System 

Introduction 

3CX Phone System is easy to monitor for any Windows administrator, since it behaves 

just like any other Windows Server application. You can monitor 3CX Phone System 

using your favourite network monitoring solution, such as for example ActiveXperts or 

Microsoft Operations manager. 

Things to monitor 

3CX services 

A good first check is to monitor all 3CX services are running. You can view all 3CX 

services from the services node in the 3CX Management Console. Any network 

monitoring package can monitor windows services remotely. 

Windows events 

The following events are posted and should be monitored using your network monitoring 

package: 

[CM104001]: -- “registration failed because specified destination could not be resolved or 

doesn't respond” 

This event occurs when the remote VOIP provider could not be contacted. This could 

occur when your internet connection is down or the specified IP or FQDN for the VoIP 

provider is incorrect or down. 

[CM104002]: -- destination has responded with error code.  

This event occurs when the VOIP provider responds with an error, for example, it could 

be that your account has been disabled 

Performance monitors 

You can monitor the following performance monitors using Windows Performance 

Monitor. To do this,  

1. Start-up Performance monitor, and click on the system monitor node.  

2. Click on the new button in the toolbar to add a new counter set.  
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Screenshot 22 - Adding 3CX Performance Monitors 

3. Now right click on the right screen and select ‘Add Counters’ to add counters to this 

set. In the performance object drop down box, select 3CX PerfMon. You can then choose 

from any of the following performance monitors: 

# Extensions = Total number of extensions 

# Registered Extensions    = Number of registered extensions 

# Ext Lines        = Total number of external lines 

# PSTN Lines    = Total number of PSTN lines 

# registered PSTN Lines= Total number of registered PSTN lines 

# VoIP Lines            = Total number of VoIP lines 

# reg'ed VoIP Lines  = Total number of registered VoIP lines 

# Completed Calls    = Number of completed calls 

# Active Calls           = Number of active calls 

# Successful Calls     = Number of successful calls 

# Failed Calls            = Number of failed calls 

# Successful Auth's    = Number of successful authentications 

# Failed Auth's          = Number of failed authentications 

Monitor IP’s of gateways and phone system 

Additionally, you should create checks that regularly check the IP of any VoIP gateway as 

well as the phone system to ensure that they are up and running 
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16. Troubleshooting 

Introduction  

If you have problems configuring 3CX Phone System, you can access the following 

sources of information for help: 

· The manual – most issues can be solved by reading the manual. 

· The 3CX FAQ – http://www.3cx.com/support/index.html 

· The Phone configuration guides – http://www.3cx.com/sip-phones/index.html 

· The Gateway configuration guides - http://www.3cx.com/voip-gateways/index.html 

· The Support forum – http://www.3cx.com/forums/ 

· Our support system 

Manual 

The manual describes the installation process in detail. Many of the questions we receive 

in support are clearly documented in the manual. You can always find the latest version 

of the manual here: 

http://www.3cx.com/support/index.html 

Configuration guides 

Be sure to follow the configuration guides for your gateway or sip phone: 

· SIP Phone configuration guides – http://www.3cx.com/sip-phones/index.html 

· VOIP Gateway configuration guides - http://www.3cx.com/voip-gateways/index.html 

Support FAQ 

3CX maintains an FAQ, which includes answers to the most common problems. If you 

have a problem, please consult the FAQ first. The FAQ can be found at 

http://www.3cx.com/support/index.html 

Request support via our support system  

If you have purchased a support package from 3CX, you can contact the 3CX support 

department via the support system. Login details would have been provided to you by 

email. 

When requesting support, include the ‘Support info’ data. 3CX Phone System can 

automatically generate a file which includes all relevant support information. NO 

PASSWORDS TO PHONES OR VOIP PROVIDERS WILL BE INCLUDED. The data will 

http://www.3cx.com/support/index.html
http://www.3cx.com/sip-phones/index.html
http://www.3cx.com/sip-phones/index.html
http://www.3cx.com/sip-phones/index.html
http://www.3cx.com/voip-gateways/index.html
http://www.3cx.com/voip-gateways/index.html
http://www.3cx.com/voip-gateways/index.html
http://www.3cx.com/forums/
http://www.3cx.com/support/index.html
http://www.3cx.com/sip-phones/index.html
http://www.3cx.com/sip-phones/index.html
http://www.3cx.com/sip-phones/index.html
http://www.3cx.com/voip-gateways/index.html
http://www.3cx.com/voip-gateways/index.html
http://www.3cx.com/voip-gateways/index.html
http://www.3cx.com/support/index.html
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NOT be sent automatically. You will be prompted for a location to save the data, so you 

can check what data will be sent to us before you send it to us.  

To generate the support info file: 

1. In the 3CX Phone System Program Group, start the ‘Backup and Restore’ tool. 

2. Click on the button ‘Browse’ next to ‘Generate Support’. 

3. You will be prompted for a location to save the data. Enter the file name to be 

generated. You can review the data that will be sent prior to sending it to us. 

4. Login to the 3CX support system, and attach the information to your support request.  

5. Include a detailed problem description. It should clearly indicate what the exact 

problem is, and when it occurs. Mention what hardware or VoIP provider you are 

using with 3CX Phone System. 
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